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Goals And Objectives websense

Troubleshooting procedures and diagnostics
Avallable resources
Directory Synchronization
Testing for latency
Endpoint client
Proxied Connections versus Non-Proxied Destinations
User authentication
Best practices and tips

Demonstration resolving common filtering issues



echnical Support Resources websense

Websense Technical Support site

Knowledge base articles
Limit search criteria to Cloud Web service
Wildcards versus explicit searching
Use quotes for “exact match”

We b S e n S e Te C h n i C aI L i b rary Overview  Support By Product  Solution Center  Technical Library  Forums  Tools & Policies  Contact Support
. Search Results | "Directory Sync Client” m
Cloud Web Security documents

Include only these products:

O r a Directory Sync Client not synchronizing the NetBIOS Domain ... &

Results View: Detail | Brief

[ Web Security and Fifter N N
Problem Description. Why is Directory Sync Client not synchronizing NetBIOS

[ Web Security Gateway Domain name? ... Run a "Test Update" on the Directory Sync Client.
Summary: Update the NTLM Identity parameter.
[ Web Security Gateway Product: Cloud Web Security

Anywhere

H O m e > S u p po rt > S u m m a.ry Directory Sync Client logs, settings and configuration files #

..« The latest Directory Sync Client console provides access to view all ... Windows
2008 R2 Server: (Directory Synchronization Client Version 1.1-RC2): ...

i Summary: Article presents paths for logs, settings, and configuration files.

] CECIEEETiy Product: Cloud Web Security

D e I I I O n St ratl O n I Avpliance Launching Directory Sync Client produces Java memory error &

Problem Description. Why do I see a Java memory error when launching
Directery Sync Client? Resolution. Using notepad ...
Summary: Manually limit java's starting memory or increase the paging file.
Product: Cloud Web Security, Cloud Email Security

[T Data Security

[~ Mobile Security

m SurfControl

what products do I have?

Error appears when Directory Sync Client access LDAP &
Include only these resources: ... the following error when Directory Synchronization Client tries connecting
to Active Directory? ... In the Directory Sync Client (DSC) application ...

Summary: Check AD account in DSC.
Product: Cloud Web Security Version: All

[ ‘g Solution Center

[T (&) Technical Library
Directory Sync Client upload to Cloud Web service fails ¥

... details as to why Directory Synchronization failed. ... duplicate email address
existing in Active Directory. ... to the Filters section in Directory Sync Client. ...

Checlc for duplicate user accounts (email addresses).

- R Forums

Summa



http://www.websense.com/content/support.aspx
http://www.websense.com/content/support/library/websense-hosted-web-security-technical-library.aspx

Troubleshooting And Diagnostic Points websense
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Directory Synchronization websense

Cloud Portal

Account Settings > Settings > Directory Synchronization
Cloud Sync settings

To remove objects, disable Synchronization and delete
Directory Sync Client application download
Directory Sync Client product Admin Guide
Synchronization activity details
Verify users
Account Settings > Settings > End Users > Search
Account Settings > Settings > Contacts > serv_acct

Directory Sync Client uses this contact to access the portal
Logging in to portal forces password expiration. DO NOT LOGIN!

Home > Reports > Services
Provides Sync history log and time summary reports

Demonstration



Directory Synchronization websense

Directory Sync Client application
Buttons
Log file viewer

Repository, change from portal to local file
Repeat steps on Groups and Users tabs

Modify > Data Repository > Type > File > Next > File_Name >
Location > Save

Directory Referral Checker

DSC > View > Directory Referral Checker > Start
Configuration file

C:\ProgramData\DirSyncClient\configurations\
Best practice

Configure SMTP to email directory synchronization notifications

Schedule directory synchronization twice daily
Set Threshold limits

Demonstration
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Performance And Latency weksense

Portal

Cloud Web Security monitoring tool
Web Security > Settings > Configuration Info

Report

Web Security > Reports > Volumes > Show > Web Performance -
Detailed web response time data

End user tests

Test for latency when using Cloud Web or Hybrid service
nslookup -query=TXT ...
Geo |IP Services and Websense Data Center IP addresses
tracert
ping
Demonstration



https://emea.salesforce.com/articles/Knowledge_Article/Latency-with-the-HWS-or-WSGA-Hybrid?popup=true
https://www.websense.com/support/article/kbarticle/Latency-with-the-HWS-or-WSGA-Hybrid
https://www.websense.com/support/article/kbarticle/Latency-with-the-HWS-or-WSGA-Hybrid
https://www.websense.com/support/article/kbarticle/Latency-with-the-HWS-or-WSGA-Hybrid
http://www.maxmind.com/en/home
http://www.websense.com/support/article/kbarticle/Hosted-Service-Cluster-IP-Addresses-and-Port-Number
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Endpoint Client weksense

Portal

Endpoint installer, use the latest build
Test, by pushing out new build with a temporary policy
NOTE: Firefox updates often, endpoint may not support latest release

Forgotten password
Reset anti-tampering password, endpoint clients update automatically

Reports
Web Security > Reports > Authentication and Endpoint
Endpoint client
Verify installation registry key
Debug options

Websense\Websense Endpoint\ClientInfo.exe
Packet capture - Wireshark

Stop Web endpoint: wepsvc -stop -password <password> wspxy
Demonstration



Endpoint Client weksense

Roaming users with endpoint client

Synchronized users using domain login are not prompted
Provides true transparent identification

Endpoint installed, but users still receive login request

User not synchronized g Whoare you?
1 You ar i ntify yo
S e r O g S I n O C a y Choose from the following options
Incorrect or no WSCONTEXT o S
Log in if you have already registered your  Register if you have never registered
email address to access the Internet. your email address to access the Intemet
that you have
Forgot password

Login failure

Avoid endpoint login request oo
Synchronize users with Cloud service
Directory Sync Client works perfectly for this
Users do not authenticate, they login with cached credentials

Roaming users without endpoint client
Always prompted for login credentials
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Connections websense

Policy has defined Proxied Connections = === =
Your external firewall IP address ==
A policy can have one or more Proxied Connections
A Proxied Connection can exist in only one policy
The Proxied Connection determines the applied policy
Transparent identification
End user’s browser replies to 407 request with credentials
Policy has NO defined Proxied Connections
All users are treated as remote users and must log in
The policy is determined by the user’s email domain

Non-Proxied Destinations
Destinations are added to your organization’s PAC file

Can be a domain name, IP address or IP subnet
Avoids connecting to Cloud proxy service for certain sites




Filtering Order websense

Filtering order for Standard or Custom Web categories:
Security category blocking

Application control blocking, File extension blocking, File type
blocking, File Size blocking

Allow access

Require user authentication
Confirm

Quota

Block access

Do not block

When per-time, per-user, or per-group exceptions exist:
Per-time
Per-user
Per-group
Default



Filtering websense

Custom categories
Created at the account level—apply to all policies
Exceptions apply to per-time, per-user, or per-group
Requires user authentication

Allow exception overrides only the Block action on URL
categories, does not bypass authentication and antivirus

Separate entries by commas
multiple email addresses, domains or user names

Demonstration
Exceptions
Custom categories
Bypass for authentication, endpoint and certificates



Additional Resources websense

+ Articles:
— Directory Sync Client logs, settings and configuration files
— Filtering actions and Filtering action order
— Proxied Connections and Non-Proxied Destinations

— Cloud service Data Center (cluster) IP addresses and port
numbers

— How can | deploy Web Endpoint?
— How do | uninstall the Web Endpoint?
— Verify using Cloud proxy and determine active policy
 How do | query Cloud service for hidden connection info?
» Past Webinars:
— May 2013: Administering the Cloud Web Security Solution

— April 2013: Introducing and confiquring Cloud Web
Security solution



https://www.websense.com/support/article/kbarticle/Directory-synchronization-Client-useful-folders
https://www.websense.com/support/article/kbarticle/Directory-synchronization-Client-useful-folders
http://www.websense.com/content/support/library/web/hosted/admin_guide/dispositions.aspx
http://www.websense.com/content/support/library/web/hosted/admin_guide/dispositions.aspx
http://www.websense.com/content/support/library/web/hosted/admin_guide/disposition_order.aspx
http://www.websense.com/content/support/library/web/hosted/admin_guide/disposition_order.aspx
http://www.websense.com/content/support/library/web/hosted/admin_guide/wd_policy_connections.aspx
http://www.websense.com/content/support/library/web/hosted/admin_guide/wd_policy_connections.aspx
http://www.websense.com/content/support/library/web/hosted/admin_guide/wd_policy_connections.aspx
http://www.websense.com/support/article/kbarticle/Hosted-Service-Cluster-IP-Addresses-and-Port-Number
http://www.websense.com/support/article/kbarticle/Hosted-Service-Cluster-IP-Addresses-and-Port-Number
http://www.websense.com/content/support/library/web/hosted/admin_guide/endpoint_dl.aspx
http://www.websense.com/content/support/library/web/hosted/admin_guide/endpoint_dl.aspx
http://www.websense.com/content/support/library/web/hosted/admin_guide/endpoint_dl.aspx
https://www.websense.com/support/article/kbarticle/How-to-uninstall-Websense-Endpoint-Client-for-Hosted-Web-Security
https://www.websense.com/support/article/kbarticle/How-to-uninstall-Websense-Endpoint-Client-for-Hosted-Web-Security
https://www.websense.com/support/article/kbarticle/How-to-uninstall-Websense-Endpoint-Client-for-Hosted-Web-Security
https://www.websense.com/support/article/kbarticle/How-to-uninstall-Websense-Endpoint-Client-for-Hosted-Web-Security
https://www.websense.com/support/article/t-kbarticle/How-do-I-query-Cloud-service-for-hidden-connection-information
https://www.websense.com/support/article/t-kbarticle/How-do-I-query-Cloud-service-for-hidden-connection-information
http://www.websense.com/content/SupportWebinars.aspx
http://www.websense.com/content/SupportWebinars.aspx
http://www.websense.com/content/SupportWebinars.aspx
http://www.websense.com/content/SupportWebinars.aspx
http://www.websense.com/content/SupportWebinars.aspx
http://www.websense.com/content/SupportWebinars.aspx
http://www.websense.com/content/SupportWebinars.aspx
http://www.websense.com/content/SupportWebinars.aspx

Upcoming Webinar websense

A note to our customers,

Our Technical Support site is undergoing a number
of updates. We want to provide our customers with
a wider range of topics and product groups.

Websense Technical Support will re-launch the
support webinars in September 2013. Stay tuned for
some great changes!

Webinar

Update

Your feedback helps us refine and improve our
ongoing webinar series. If you have any questions
or suggestions, please email the webinar team at
esupport@websense.com.

Thank you,



mailto:esupport@websense.com

Training websense

Websense Training
Partners offer classes
online and onsite at your

Websense Customer Training

Designed for:

location. -
= System administrators
= Network engineers
= Other members of your organization as
For more information, ApprapHaie
p|ease send email to: Training locations:
i All training is conducted at Authorized Training
readiness@websense.com Centers (ATCs). Each ATC has information on

costs, course schedules, and types of classes (in-
person, virtual, or computer-based).

To find Websense classes

offered by Authorized

Training Partners in your

area, Visit: = S—
www.websense.com/findaclass



http://www.websense.com/findaclass
mailto:readiness@websense.com
http://www.websense.com/content/TrainingCustomers.aspx

